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Disclaimers and Legal Information
Copyright © 2015 Aimetis Inc. All rights reserved.
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Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any
means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written
permission of Aimetis Corp.
Aimetis may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject
matter in this document. Except as expressly provided in any written license agreement from Aimetis, the furnishing of this
document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.
Aimetis and Aimetis Symphony are either registered trademarks or trademarks of Aimetis Corp. in the United States and/or
other countries.
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Description
Release 6.13.2.4
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Release 6.13.2.2 not generally released
Release 6.13.2.1 not generally released
Release 6.13.2
Release 6.13.1.4
Release 6.13.1.3
Release 6.13.1.2
Release 6.13.1.1
Release 6.13.1
Release 6.13.0.3
Release 6.13.0.2
Release 6.13.0.1
Release 6.13
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Release 6.13.2.4
Fixed
Fixed
AIR-24288

Symphony Client no longer displaying erroneous popup message to delete
camera from farm

Release 6.13.2.3 not generally released
Fixed
Fixed
AIR-24288

Symphony Client no longer displaying erroneous popup message to delete
camera from farm

Release 6.13.2.2 not generally released
Fixed
Fixed
AIR-24237
AIR-24238

Axis P7016 encoder tracker CPU usage decreased
Multiple ADAM devices on one server working correctly on failover

Release 6.13.2.1 not generally released
Fixed
Fixed
AIR-24077

Heatmap report contains correct and complete data for recorded days
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Release 6.13.2
Includes previously privately released 6.13.1.x patch updates as of August through October
2014.

Improved
Improved
AIR-1944
AIR-7687

AIR-17463

AIR-21863

AIR-21864

AIR-22284
AIR-22911

Digital zoom available for videos played in Symphony Player
Analytics: New video record mode added: Schedule and Pixel Changes Detected
by PC that records whenever pixel changes are detected as objects are tracked
through the scene, but only during the time period specified.
Note: The Symphony license determines which Analytics options are available.
Analytics: Display warning on video "Dropping frames due to insufficient
processing resources. Try reducing analytics resource needs" for supported
cameras when frames are not processed quickly enough or frames are dropped
On Client Settings > Maps tab, you can now define whether rule icons are always
visible with a specific colour and transparency level using the Always show rule
icon, Default color, and Transparency options.

When configured, all rule icons on maps share the same color (and any
configured transparency value) when not in an alarm. When an alarm occurs, the
rule icons can be different colours, as defined on the Alarms tab.
When a camera is set to Switch view when an alarm occurs, you can now lock
and unlock the current video using a keystroke in addition to right-clicking and
selecting Enable Automatic Switching.
Press and hold SHIFT and click the video panel to temporarily pause and prevent
camera switching. Repeat it to resume camera switching.
(ShowEventSwitchingLock=True must be set in the acc.ini file)
See: http://www.aimetis.com/Support/kbarticle.aspx?ID=10326
Improved alarm generation
Help now available online and in Symphony installation
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Improved
AIR-23417
AIR-23437
AIR-23543
AIR-23553
AIR-23568
AIR-23847
AIR-23947

SDK changes – See SDK documentation
PTZ location displayed on Live and Historical views
VE180 Outdoor default interface parameters updated
SDK: User can stop video via new None Camera option
AXIS Edge Storage: download process from SD card restarted automatically after
interruption
Erroneous switching to port 1756 in direct connection to Bosch camera corrected
Export Video now has option to include Symphony Player when exporting aira
files

Fixed
Fixed
AIR-11141
AIR-11266
AIR-12008
AIR-16928
AIR-17463
AIR-17894
AIR-20240
AIR-20879
AIR-20921
AIR-22302
AIR-22551
AIR-22769
AIR-22839
AIR-22857

AIR-22882
AIR-22936
AIR-22967

Emailing picture as linking working correctly
Correct image saved/displayed when selecting Send Picture To in multiview
Full image saved when Send Picture To selected in live/recorded video
Help > Report an Issue includes all server logs
For high CPU usage with PT091 and VE180, warning message displayed:
“Dropping frames due to insufficient processing resources”
RTSP URL video format setting saved and applied correctly
Videowall: Working correctly when loading new device model
Farm reporting correct version after backup restored
Alarm log alarm rule names no longer displaying as blank
Server > Video Wall option no longer causing the Client to hang
Johnson Controls P2000 Access Control working correctly - multiple rules can be
tied to the same events and the same alarm camera
Multiviews working correctly with two or more PTZ cameras using joystick control
LPR functioning correctly in Windows 7, Chinese edition
Re-starting Symphony services via the Client re-enables and restarts all tracker
services, even trackers currently disabled.
The following setting configured via the Manual Configuration Editor ensures that
trackers remain disabled when services are restarted:
Type: Global
Section: Main
ID: <empty string>
Key: EnableTrackersBeforeStart
Value: <either “true” or “false”> - set to “false” to ensure that disabled trackers
remain disabled after a service restart
LPR working correctly. “License plate recognition hardware lock error” avoided
Video rendering improvements implemented
Frame rate variances causing unsynchronized playback resolved
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Fixed
AIR-23034
AIR-23038
AIR-23074
AIR-23119
AIR-23121
AIR-23124
AIR-23125

AIR-23154
AIR-23155
AIR-23156
AIR-23176
AIR-23177

AIR-23192
AIR-23193
AIR-23194
AIR-23195
AIR-23196
AIR-23197
AIR-23198
AIR-23199
AIR-23200
AIR-23201

Web Client timeline displays the PTZ Auto tracking timeline (pink line) indicators
correctly
Server > Services > Manage Symphony Services > AI Infoservice > Toggle no
longer producing erroneous error
Decoration “camera tour enabled” visible when Camera Tour enabled (Right-click
on live video > Camera Tour > Enable)
After connecting to the Gallagher access control device initially, checkbox options
can be selected
Privacy masks working correctly for edge storage historical video
Connecting to Access Device with incorrect credentials displays appropriate error
Clicking Ignore when you see a “Server is not connected” message now adds that
server to an acknowledged list, and users now only see unacknowledged server
messages display
SDK: Alarm Time displaying server’s local time instead of Coordinated Universal
Time (UTC)
SDK: Privacy masks working correctly
Note: Privacy mask is not applied in direct mode
Privacy Masks working correctly with rules, video searches, and when managing
analytics configuration
Chinese characters correctly displayed in playback video
The URL to access the Web Client with username, password, and a live video of a
specific camera ID using URL variables has been changed to:
http://[SERVERNAME]:50000/login.aspx?U=jsmith&P=FIY1TQ %3D&C=7&R=1
See the KB article https://www.aimetis.com/Support/kbarticle.aspx?ID=10311 for
further details.
Decoration color settings propagated throughout all servers in the server farm
correctly
Server Configuration dialog Server field displays the hostname of the server
where the device is connected
SDK: Panel switching working correctly
Device List correctly populated following server upgrade
Disabled PTZ notifications include usernames which are visible only to users with
administrative privileges
Phoenix: Input mapping corrections implemented to prevent missing and
duplicate input triggers
Video decoration font improvements implemented
Licensing working correctly in large multi-server farms where servers have
multiple MAC addresses and network interface controllers
When a connection is lost, or a camera moves to a different server, client
reconnects to historical video stream correctly
Camera tree updating immediately following device model changes.
New devices added show with ID of 0 until the server updates with the correct
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Fixed
AIR-23202
AIR-23203
AIR-23204
AIR-23205
AIR-23206
AIR-23207
AIR-23208
AIR-23210
AIR-23211

AIR-23228
AIR-23234
AIR-23241
AIR-23243
AIR-23244
AIR-23245
AIR-23250
AIR-23246
AIR-23247

camera ID
Videowall: Mixed mode working correctly where server version is different than
client version
Videowall: In a multi-server farm environment, concurrent panel switch
commands working correctly
Creating a New Camera View from an existing camera group working correctly
Device Tree Configuration Cancel option working correctly
Device model changes applied correctly when the Server Configuration dialog is
open
When importing a PTZ camera as a fixed camera, editing the camera’s device
configuration overwrites the camera type correctly
Maps: Client connection status visible in Maps panel
Web Client: Server connection performance and logging enhancements
implemented
Video recording stops correctly when an alarm is triggered for a camera set to
never record with a post-event buffer; recording stops when the entire postevent buffer is complete
Creating and managing map links no longer result in duplicate data
VE150 and VE180 showing images in the correct aspect ratio
Timeline: Purple circle displays the correct time
Restricted users can view live video when the database is unavailable
Moving digital I/O devices to another server signalled correctly via SNMP
Timeline: Purple circle indicating the current video panel position displaying
correctly
Speed improvements implemented when switching live video via direct
connection
You can now hide the mouse cursor on live video displaying on any video panel.
When this feature is enabled, the mouse cursor disappears after five (5) seconds
of mouse inactivity. The cursor reappears immediately when the mouse moves or
when an alarm popup appears in the system tray.
This feature is disabled by default. To enable the feature per server, edit
%appdata%\<ProductFolder>\acc.ini and change the following parameter as
needed:
[CameraVideoView]
CursorOffOnVideo=True

AIR-23249
AIR-23251
AIR-23253

Note: When an Alarm popup appears in the system tray, the cursor disappears
five (5) seconds later until another alarm is detected.
Setup Wizard working correctly in silent mode
Viewing blank camera working correctly
Symphony Manager services working correctly for users with Administration
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Fixed
AIR-23254
AIR-23255
AIR-23256
AIR-23257
AIR-23258
AIR-23259
AIR-23260
AIR-23261
AIR-23262
AIR-23264
AIR-23265
AIR-23266
AIR-23267
AIR-23268

AIR-23269
AIR-23271
AIR-23252
AIR-23263
AIR-23270
AIR-23272
AIR-23273
AIR-23274
AIR-23275
AIR-23276
AIR-23277

AIR-23278
AIR-23295
AIR-23304

privileges
Web Client: Banning and unbanning video no longer causes camera tree display
issues
Changing video decoration transparency working correctly
Users Viewing Camera option refreshing correctly when logged in user changed
Help > Report an Issue > Upload to Aimetis option saves file to desktop correctly
Video export working correctly
Device Tree configuration Apply option no longer resulting in Client crash
Web Client: Server popup messages display and refresh correctly showing a
maximum of 3 messages at any time
Videowall: No longer logging erroneous “Failed to connect to videowall
controller” error during load balancing
Web Client: Timeline hidden after banning device
Switch view when an alarm occurs functionality working correctly without
logging erroneous exceptions
Videowall: Decoration transparency settings pushed correctly to all viewers
Videowall Manager: No longer logging error when changing video quality
Videowall: Performance improvements implemented
Server Configuration > General Settings > Decoration Text Background color
preview displays the color name for Black and White and specific RGB values for
any other specified color
Note: Color preview does not include any configured Transparency value
When attempting to switch panels using the SDK to unregistered clients, a
notification error is displayed
Videowall: Clicking Refresh in Videowall Manager working correctly
Videowall: No longer logging erroneous errors when switching panels

Videowall: Blue panel errors no longer displaying and File > Send Picture working
correctly
Digital I/O rules import and export via CSV loading policies and rules correctly
View Current Logins functionality (Server > View Logins > Current Logins) displays
computer hostnames only and not IP addresses
Client lock Panel add/Panel close functionality working correctly
View > Settings > Lock > Panel adding/closing hides related menu buttons and
their associated View menu options
Modifications to Messenger message text size and position are correctly applied
and updated
Vivotek: Live & historical audio sound working correctly
VE180: Outdoor Mode > Advanced Configuration > New Object Min Travel
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Fixed
AIR-23325
AIR-23327

AIR-23328

AIR-23351
AIR-23352
AIR-23356
AIR-23358
AIR-23359
AIR-23360
AIR-23363
AIR-23362
AIR-23364
AIR-23365
AIR-23366
AIR-23639
AIR-23390
AIR-23398
AIR-23399
AIR-23406

AIR-23417

AIR-23423
AIR-23429

(Meters) Distance default set to 1.0 m
Client no longer locked for up to 30 seconds when exporting video from server
with older software version
View > Settings > Maps > Always show maps icon option & color selection
defines rule color correctly when a rule is dragged onto a map and when rule is
triggered. Support also added for custom colors.
SDK: Able to get historical JPEG for the selected time or a current JPEG through
LiveStreamTest as desired. In the Alarms section can now request to fetch new
alarms on demand.
Automatic backup upload failures no longer resulting in the storage of multiple,
unnecessary backup files
Server > Backup working correctly locally and online
Following a Symphony upgrade, accessing historical video captured prior to the
upgrade working correctly
Opening Server > User Configuration no longer hanging intermittently
Client interface unlock functionality no longer displaying erroneous permission
error
Client interface refresh and video playback performance improvements for
deployments with many devices
Manually overriding camera record mode working correctly
Touching a hidden mouse cursor no longer results in an erroneous error message
when playing historical video
Device I/O triggering alarms correctly during database outage
Multiple cameras video export working correctly
Setup wizard working correctly in silent mode
Cameras successfully moved during server merge
Adding a second video stream when Symphony storage (Server > Configuration >
Storage) is configured to use Max Days working correctly
New Report > Heat Map Report > Next Page> Camera Selection> Heat Map
view> Select Different Image option results in error message “Failed to get image
from camera” when camera is disconnected
Interface improvements implemented, including the ability to:
 Subscribe to live events over a TCP stream
 Retrieve historical events via Mobile Bridge Server
 Subscribe to specific Symphony events including rules and license plate
detections
An SDK sample demonstrates how to get historical alarm & LPR events from
Mobile Bridge, as well as subscribe to and unsubscribe from live events.
Chinese: “Connection Failed” message translated
SDK: Clicking Mark Alarm in a Live Stream Test with no alarm selected no longer
displays erroneous error message
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Fixed
AIR-23431
AIR-23432
AIR-23441
AIR-23442
AIR-23443
AIR-23471
AIR-23473
AIR-23508

AIR-23523
AIR-23529
AIR-23532
AIR-23533
AIR-23546
AIR-23554
AIR-23555
AIR-23558
AIR-23580
AIR-23593
AIR-23594
AIR-23596
AIR-23597
AIR-23599
AIR-23640
AIR-23647
AIR-23651
AIR-23705
AIR-23707

SDK: During a Live Stream Test, clicking on any option no longer switches the
current camera to another camera
SDK: SSL support added to Mobile Bridge SDK sample application
Server > Configuration > Swap Servers working correctly
Switching to a docked quad view working correctly
VE140/VE141: Choose Image button removed since these algorithms are not
configurable
SDK: Adding alarms to camera and inserting alarms working correctly
Rules: Importing cameras via CSV file for an alarm event rule working correctly
Changing the analysis resolution on one tour location for a PTZ camera tour no
longer displays erroneous on-screen error message when the camera moves to
that location
Camera Setup for RTSP video streams added to the Device Tree working correctly
Changing between different multiple camera views working correctly
SDK: Mobile Bridge returns a current JPG regardless of whether or not the tracker
is configured to record
Corrected issue where the permission system became partially corrupt if multiple
users adjusted the same permission at the same time
When resizing the video area, video playback continues to play correctly
SDK: Mobile Bridge live video displayed only once camera is selected
Video export working correctly
SDK: Mobile Bridge camera list working correctly after disconnecting and
reconnecting to a server farm
Setup Wizard completion no longer erroneously runs Windows Program
Compatibility Assistant
When de-warping historical video, the Send Picture to option dewarps the video
image correctly
Switching cameras in the Device Tree to configure a camera that is off is working
correctly
SDK: Export Video sample includes a Disconnect button to change the farm for
video export
SDK: Mobile Bridge camera option None blanks camera view
Modifying locations and camera tours and closing camera views working correctly
SDK: Mobile Bridge camera additions and deletions working correctly
Direct connect video displays proper date and time
SDK: Export video sample working correctly
Changing algorithms when the PT091 analytic and dual video streams are enabled
is working correctly
Users are notified when event log data is unavailable via Server > View Logins
and Help > View Detailed Events due to the Event Log being disabled (Server >
Configuration > General Settings > Event Log > Enable Event Log)
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Fixed
AIR-23722
AIR-23848
AIR-23859
AIR-23921
AIR-23950

Lost Camera Connection alarms are received and camera connections are not reestablished in the event that the database becomes temporarily unavailable
Chinese: STMP server label size adjusted to fit text
Restoring configuration from backup on multi-server farm working successfully
Log cleaning issue corrected to rectify issue of multiple trackers found in stopped
state and unsuccessful fail-over
Daily scheduled alarm report working correctly on multi-server farm.
Important: Reports are run only on master servers.

Release 6.13.1.4
(Not generally released)

Fixed
Fixed
AIR-23584

AIR-23587

SDK: Farm Test sample includes a new Loop Video option and a Video Length
(seconds) control. When Loop Video is enabled, switching the panel to the
historical video loops the video for the length of time specified.
Camera tour location name decoration available for live and historical video
See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10320 for details

Release 6.13.1.3
(Not generally released)

Fixed
Fixed
AIR-23412
AIR-23413

WebClient: Timeline is hidden immediately after banning a device
WebClient: Reloading URL to show specific camera correctly displays live video
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Release 6.13.1.2
Fixed
Fixed
AIR-23388

Following a Symphony upgrade, able to access historical video captured prior to
the upgrade

Release 6.13.1.1
Fixed
Fixed
AIR-23393

Client no longer locked for up to 30 seconds when exporting video from server
with older software version
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Release 6.13.1
Includes previously privately released 6.13.0.1, 6.13.0.2, and 6.13.0.3 patch updates.

New
New
VIS-86

VE180 Outdoor Multi-Class Object Tracking implemented and features the
following improvements:
 increased robustness to environmental conditions
 better suppression of shadows
 updated object overlap penalty to prevent tracking boxes within masked
out regions
 reduction of CPU usage

AIR-19295

Automatic calibration support added for perspective cameras (overhead or
angled view)

AIR-20624

Automatic calibration added to VE180 analytics configuration for supported
devices.
Automatic calibration determines the optimal camera configuration for scenes
containing people. You can switch to manual calibration at any time, and the
system retains the last best estimation of camera position detected.
Auto Calibration option available in Server Configuration > Devices > Analytics
Configuration > Overview > Camera Position
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New

AIR-22945

Clear alarms configures how Symphony Client clears alarms in the alarm log every
24 hours at midnight.
On each server, edit %appdata%\<ProductFolder>\acc.ini and change the
following parameter as needed:
[Main]
ClearAlarms = All
Values include:
 All (default) – all alarm logs are cleared
 None – alarm logs are not cleared
 Marked – only alarm logs marked as acknowledged
 Viewed – only alarm logs marked as viewed are cleared
Note: Alarms generated less than 24 hours in the past are never deleted
regardless of how the Client is configured.
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Improved
Improved
AIR-20083
AIR-22334
AIR-22846
AIR-22749

AIR-22901
AIR-22993
AIR-23083
AIR-22944
AIR-23026

AIR-23031

Support added for Windows 8.1 Enterprise Edition, 64-bit Operating System
Arecont: Auto Discovery support added via Server Configuration > Discover
Devices feature
VE180 indoor tracking shadow suppression improvements implemented
Privacy mask improvements implemented:
 % Surrounding Object – the percentage of the area the privacy blur is applied
to beyond the tracking box. Applies only to dynamic privacy masks.
 Mask Delay (seconds) – the number of seconds to remember the position of
tracked objects and continue blurring their previous position. Applies only to
dynamic privacy masks.
 Blur Amount – the amount of blur applied to the area. Applies to both static
and dynamic privacy masks.

VE180 Indoor People Tracking analytic configured for Overhead camera position
by default
Client Notification bar correctly indicates which individual servers in a multiple
server farm are down
PTZ camera response time improvements implemented
In Server Configuration > Storage, enabling the Limit the number of days video is
stored option visibly disables the Default max storage days option in the
interface
New alarms implemented:
 If the connection with the video system has been lost because the server is
disabled or shuts down or the network connection is lost
 When the video server has reconnected and is operational and/or the
network connection is re-established
 If the list of cameras (and PTZ presets) changes and the video server may
need to update its cache (such as when camera is added, deleted, or
renamed, or if a PTZ camera's presets are added, deleted, or renamed)
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Improved
AIR-23041

PT091: Calculates object speed based on tracked foreground points, when
available. If there are tracked key points in the region that don't correspond to
background motion, the PT091 analytic uses that motion data to estimate the
motion of the foreground object.

Fixed
Fixed
AIR-18360
AIR-18762
AIR-19038
AIR-20895
AIR-21424
AIR-21736
AIR-22036
AIR-22276
AIR-22374
AIR-22426
AIR-22433
AIR-22436
AIR-22441
AIR-22456
AIR-22687
AIR-22689
AIR-22690
AIR-22692
AIR-22723
AIR-22745

AIR-22758
AIR-22777

No longer displaying erroneous message after generating bug report log package
IQeye: Live video and historical video playback working correctly
Camera storage path modifications persist correctly and discarded changes are
not saved
Gallagher Access Control alarm popups working correctly
When connected to more than one server, interface responsive after switching
cameras
Device decorations, including camera name and ID, display in the center of the
live screen view
Siemens SPC device alarms being received successfully
Axiom RBH access control rule action correctly forcing associated cameras to
record
WebClient installations no longer displaying erroneous CAB errors
Visible objects that do not overlap masked-in portions of the area by 10% or
more are no longer being tracked
You are prompted to select a tracking algorithm when enabling the VE101
analytic for a device
Exporting thumbnails via Alarm Log working correctly
Multiple login deny user permission working correctly
Privacy masks are applied for rule and analytic configuration as well as video
search results for users without the appropriate permission
Map link placement improvements implemented
Client responsiveness improvements implemented during device model refresh
Static privacy mask control setting retained correctly
Device connections including adding and removing cameras working correctly
following a server IP address change
Server/Client connectivity improvements implemented
LPR: No longer generating bitmap of every image that generates an exception.
Error images now written to the standard date-and-camera directory within the
_images directory in the data folder.
Historical video playback working correctly
When playing historical video, purple circle indicates the correct Timeline position
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Fixed
AIR-22778
AIR-22811

AIR-22827
AIR-22831
AIR-22834
AIR-22837
AIR-22847
AIR-22855
AIR-22858
AIR-22882
AIR-22887
AIR-22888

AIR-22890
AIR-22905
AIR-22919
AIR-23002
AIR-23040
AIR-23057
AIR-23071
AIR-23016
AIR-23101
AIR-23122

Email on alarm functionality now correctly including attachments
When the camera is set to not record, and there is no historical video available
when the user attempts to select an image for algorithm configuration, the
system attempts to get an image from tracker instead of displaying a “no footage
found” message
Alarm popups working correctly across multi-server farms
When a device is set to record on motion detected by PC but no analytics engine
is selected, you are prompted to select a different recording mode for the device
Privacy masks working correctly using the mobile client
PTZ control panel functions working correctly
Fisheye Dewarping: PTZ buttons working correctly in wall mount mode
PTZ autotracking timeline indicator improvements implemented when the device
is not configured to raise an alarm
HTTP authentication added for auxiliary PTZ commands
LPR: Multiple cameras simultaneously running LPR no longer displaying the error
“License Plate Recognition – Hardware lock error” on the live view panels
Client is no longer erroneously applying Privacy Masks when the server is older
than 6.13
Analytics configuration is no longer freezing on load. Analytics configuration is no
longer available initially when a device is added.
You must successfully add a device, close the Server Configuration dialog, and
reopen the dialog to access the Analytics Configuration tab options.
Video export email notification working correctly
Line counting conversion working correctly without errors for non-English
Operating System installations
Video decoration font improvements implemented
Phoenix hardware device inputs and outputs being detected correctly
Server Configuration > Devices List > Server field supports server hostnames and
IP addresses
Alarm Log: Video panel working correctly in Advanced Mode when an alarm is
selected
Report distribution via email working correctly
When creating a rule for the VE180 analytic, all three (3) classes of objects are
selected by default, including: People, Vehicles, and Unknown
Client now logs when the requested analysis FPS (frames per second) value is
greater than the capture FPS
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Release 6.13.0.3
(Not generally released)

Fixed
Fixed
AIR-22884

Mobile Bridge requests for JPEG images no longer resulting in occasional
decompression errors

Release 6.13.0.2
(Not generally released)

Fixed
Fixed
AIR-22779
AIR-22862
AIR-22897
AIR-22900

Vivotek: Edge storage video downloads working correctly following connectivity
interruptions
Axis: LPR detection and privacy mask stability improvements implemented for
edge storage footage downloads
Active Directory integration working correctly when upgrading while Setup
Wizard is in offline mode
Accessing the Web Client and a live camera video working correctly
Note: Encoded Passwords that include equal signs (=) must be escaped as %3D.
See AIR-21421 for parameter details.

Release 6.13.0.1
(Not generally released)

Fixed
Fixed
AIR-22779
AIR-22819

Vivotek: Edge storage video downloads working correctly following connectivity
interruptions
Vivotek: Automatic playback stream switching working correctly
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Release 6.13
Includes previously privately released 6.12.4.x patch updates as of May 26, 2014.

New
New
AIR-20889

Dynamic and Static Privacy Masks
In Symphony analytics configuration, you can define dynamic and static privacy
blur masks per device for cases where privacy is a concern. Privacy masks can be
configured for all motion tracking video analytics in Symphony.
When privacy masks are defined, operators can validate alarms but cannot
identify people in live or historical video.
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New
Configure Privacy Masks
1. In the Symphony Client, within the Server Configuration dialog
(Server > Configuration), select a device whose analytic you want to configure
with a privacy mask.
2. Select the Analytics Configuration tab.
3. Select Privacy Mask from the Analytics Engines drop-down list.

Define a Static Privacy Mask
Static privacy masks blur the area of a drawn region for static areas such as
entrance ways.
1. Enable the Static Privacy Mask checkbox.
2. Using the displayed image from the video, define the area in gray (the privacy
mask) where objects in that defined area should be blurred.
 Select the Erase option to erase the grey privacy mask.
 Select the Draw option to draw the grey privacy mask.
 The Size slider adjusts the pen thickness.
3. Click OK to save your changes.

Define a Dynamic Privacy Mask
Dynamic privacy masks dynamically blur motion tracking boxes for moving
objects such as people walking.
1. Enable the Dynamic Privacy Mask checkbox.
2. Click OK to save your changes.

Copyright © 2015 Aimetis Corp.

21

New

Privacy masks are transmitted with decorations in live and historical video
streams with every key frame (or every eighth frame for MJPG). They are also
saved to disk.

AIR-21421

Note: Privacy masks are permission-driven. Users denied the View Private Video
permission will always see the privacy mask applied. System administrators
granted the permission will never see applied privacy masks.
Access the Web Client with username, password, and a live video of a specific
camera ID using URL variables as follows:
http://[SERVERNAME]:50000/Default.aspx?U=jsmith&P=FIY1TQ==&C=7&R=1
where:
 [SERVERNAME] is the Microsoft® Windows® Hostname or the IP address
of the Aimetis Symphony Server
 U= is the User Name
 P= is the Encoded Password (Generate the encoded password using the
Aimetis Password Encode Utility located in C:\Aimetis Symphony Install
folder\_tools\PasswordEncoder.exe)




C= is the Camera ID to load
R= prevents the server from load balancing the request by redirecting the
request to another server. Not intended for production deployments.
Note: Ensure that each variable is separated by the ampersand symbol (&).
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New
AIR-22263

Auxiliary command support added for applicable PTZ cameras and video server
devices
See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10293

Improved
Improved
AIR-18765
AIR-20786
AIR-21158
AIR-21369
AIR-21415
AIR-21459
AIR-21539
AIR-21544
AIR-21738
AIR-21778
AIR-21831
AIR-21874
AIR-21935
AIR-21936
AIR-21937
AIR-21938
AIR-22005
AIR-22011
AIR-22187
AIR-22190,
AIR-22197
AIR-22245
AIR-22324
AIR-22333
AIR-22406
AIR-22675

LPR – Can set how long to keep a license plate visible after a car has left the scene
in seconds using a new Plate Display Time field
South American LPR module support improved
PTZ Lock Timeout is ignored for PTZ calibration
Export Video right-click option added to the Timeline and available when a Start
Time and End Time is marked.
Arab LPR module support improved
Rule status correctly toggled via ADAM module
Refactored PTZ movement control logic and camera command systems for
improved stability and performance
SDK WebServiceConsole GUID argument support added
SNMP calculates footage size when redundant storage used
InfoService logs now include the location of %APPDATA% for system processes
LPR plate size on-screen draw options added and Analysis Heuristical Sensitivity
option removed
Retrieving edge storage JPEG and historical video for multi-channel AXIS video
encoders working correctly
Mexico LPR module support improved
Latin LPR module support improved
Taiwan LPR module support improved
USA/Canada LPR module support improved
PT091: Zooming can be suppressed during auto tracking
Moroccan LPR module support improved
PT091 improvements implemented to support PTZ autotracking performance
with thermal cameras
The Auto track object and Follow object to other cameras auto-tracking
commands have been removed from the live video feed right-click menu
Embedded CHM help link replaced with centralized webhelp link
LPR: Opacity of the plate rectangles set to 75% to ensure plate characters are
visible
VE180 shadow suppression improvements implemented
LPR: Default minimum and maximum value adjustments applied for the first
instance of Slant and Slope
Microsoft® Windows Server® 2012 R2 support added
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Fixed
Fixed
AIR-15738
AIR-19058
AIR-19186
AIR-20748
AIR-20861
AIR-21007
AIR-21108
AIR-21122
AIR-21155
AIR-21157

AIR-21233
AIR-21234
AIR-21307
AIR-21308
AIR-21309
AIR-21312
AIR-21313
AIR-21330
AIR-21342

AIR-21394
AIR-21414
AIR-21422,
AIR-21456
AIR-21473
AIR-21530
AIR-21617
AIR-21636
AIR-21640
AIR-21646

Camera audio plays via second stream correctly for live video, exports, and
historical video playback
ALPR working successfully in cases where motion detection chaining is disabled
PTZ panoramic mask generation working correctly
Occasional LPR crashes resolved
Alarm emails no longer missing attachments on systems configured for a nonNorth American date/time format
Client no longer logging application errors during videowall panel switching
Users can access historical data successfully
Images are cleaned at the correct time
Rule actions working correctly with Access Control devices in Symphony
Unlicensed systems display an error message when importing cameras using a
CSV file: Camera {0} could not be added. Please ensure all servers are up and
adequately licensed.
AXIS cameras recovering successfully following disconnections
Adding a second server to a server farm updates licenses correctly
Switch view on alarm working correctly
Web Client: Displaying Profile Switch messages correctly
The View Blank Camera option working correctly when viewing JPEGs
Symphony no longer exhibiting issues when camera setup does not match the
actual camera configuration
SDK VideoWallClient sample supports video wall hostnames and IP addresses
Advantech Adam-6060 digital IO: Erroneous message no longer displays when
trying to disconnect
VE180 Outdoor Mode no longer erroneously showing unknown objects when
unknown object detection is disabled; classification checkbox options for the
outdoors interface have also been removed
When supported cameras are configured for Corridor Mode, changing the frame
rate for the camera correctly adjusts on reconnect
Adding a server to an existing server farm working correctly
PTZ camera unlock and home commands are working correctly
Discover Devices ONVIF discovery working correctly
Footage maintained correctly to prevent recording gaps
Multiple email addresses separated by commas are working correctly in the
Advanced Search panel
Following storage restoration, correct time values recorded
Axiom RBH Access Control working correctly
If an unavailable storage path is detected, the system does not try to write to the
unavailable disk
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Fixed
AIR-21719
AIR-21744
AIR-21812
AIR-21822
AIR-21861
AIR-21876
AIR-21897
AIR-21900
AIR-21962
AIR-22007
AIR-22024
AIR-22026
AIR-22088
AIR-22100
AIR-22185
AIR-22192
AIR-22194
AIR-22199
AIR-22204
AIR-22216
AIR-22217
AIR-22226
AIR-22234
AIR-22237
AIR-22239
AIR-22242
AIR-22359
AIR-22360
AIR-22370

Import Cameras Template XLS file > Valid Entries tab headers are formatted
consistently
PTZ Calibration camera right-click option hidden for non-Enterprise licenses
Server merge successful when source farm contains more than eight (8) maps
Alarm times correct and in sync with alarm images
Switch User correctly updating stored credentials when the Client is configured to
prompt users for credentials at startup
Redundant storage works better in configurations with slower media
Live video camera panel views working correctly
License Configuration verification step no longer failing in Setup Wizard due to
Xnet connection timeout
Large scale solution improvements implemented
PT091: Alarm no longer erroneously detected throughout FLIR PTZ camera
autotracking
PTZ lock decoration no longer erroneously showing “ptz locked [] P[0]” when the
camera is not locked
Switching PTZ locations no longer results in an alarm click jumping to an incorrect
point in the timeline
VE180 Restore Default working correctly
Johnson Controls P2000: Alarms working correctly in a multiple server farm
environment
Searching for alarms working correctly
Erroneous empty Show Details button no longer available following a Client error
Clear alarms at midnight working correctly
CoreVision configuration parser correctly supports multiple masks by validating
mask name during mask load
Video export End Time accuracy improved
Resizing a window with dewarped JPEG resizes correctly
Removing PTZ home locations working correctly when the VE180 analytics engine
enabled
Server able to access historical video from a network drive
Servers no longer erroneously removed from the Server List as already registered
Current Timeline position (purple circle) no longer moving erroneously following
JPEG retrieval from edge storage
VE130 search for alarms only no longer results in "No footage Found " error
Unlicensed Axis camera application error no longer being erroneously logged
Axis: Device discovery working correctly via ONVIF
Setup Wizard delay increase to prevent slow internet connections to Xnet
timeouts
Remote system backups working correctly when the server farm is on a separate
network from the client
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Fixed
AIR-22461
AIR-22548
AIR-22549
AIR-22552
AIR-22557

Axis fisheye camera floating multi-view switches from fisheye to dewarp view
correctly
Web Client: Erroneous “Graph is not connected” message no longer displays after
clicking Live View button
Alarms inserted through SDK correctly displayed on Symphony Web Client Alarm
Log
Manual Configuration Editor interface OK button enabled when a cell value is
updated
VE180: When creating a new rule, interface refresh issues resolved when clicking
Refresh Image button on the Event tab
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